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1 Introduction

Optical simulations have long been a central part of research and development.

From developing car headlights to understanding excitation mechanisms in solar

power, optical simulations become increasingly important. Not only are optical

simulations used in research and industrial applications but in leisure applications

as well. 3D graphics in computer aided design and computer animations use

ray tracing to improve appearance of lighting. Video games have included ray

tracing options to improve the quality of lighting in the game, and consumer

graphics cards are shipping out with specific ray tracing cores which accelerate

the calculations required for ray tracing applications. Ray tracing will play a

central role to describe how light interacts with matter without the need to solve

complicated differential equations.

In this thesis, I explore the optical properties of face masks in response

to UV light. The general underlying hypothesis is that a face mask can be

decontaminated by exposing the face mask to UV light. This has already been

shown to be possible in a Bachelor’s thesis by Titta Kiiskinen. [1] In this thesis,

I will explore the methods of creating a model for use in optical simulations

in TracePro from an x-ray tomography image. I will also use ray tracing to

determine the attenuation of light inside a face mask structure. The attenuation

of light inside the structure of a face mask plays an important role in modelling

the decontamination of face masks using UV light.

The optical properties of face mask structures are characterised experiment-

ally using reflection and transmission studies in the UV range, using two separate

measurement devices. The simulations are performed on 3D models constructed

from X-ray tomography images, with a ray tracing software. Ray tracing has been

chosen as the simulation method, since it is relatively fast compared to solving

complex differential equations. Another reason for the choice is that the software

used to complete the simulations is commercially available.

During the Covid-19 pandemic that swept over the world in 2020, there

was a greater need for protective equipment such as face masks. This lead to a

shortage of face masks since they can primarily only be used once. Not only did

the increase in demand of face masks result in a shortage of them but also in
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greater plastic pollution. Several solutions have been proposed to the problem,

among them UV-C decontamination of face masks in a decontamination room.

[2]

Similar studies have been done when it comes to characterising face mask

materials and structures. [3] Yet there were no studies found where forward ray

tracing was the primary tool for analysis of the random structures. A Bachelor’s

thesis has been written by Pinja Helasuo in which measurements were completed

on organised woven textile structures. The simulation setup is of great interest

and in this thesis a similar setup to Helasuo’s was used. [4] This study is com-

pleted as a part of the Citizen Shield project, carried out in collaboration with

VTT Technical Research Centre of Finland Ltd and Universities of Tampere and

Helsinki. Citizen Shield is set up to aid the security of supply in Finland. Not

only is the research based on technical input, such as this thesis, but on behavi-

oural research as well. The importance of the research done in this project has

been amplified during the SARS-CoV-2 pandemic starting in late 2019.

1.1 Face mask decontamination using UV light

In her thesis, Kiiskinen [1] explored the possibility of face mask decontamination

using UV light. The study was performed by contaminating a face mask with

microbes and then exposing the face mask to UV light from a controlled source.

By taking swab tests from face masks with different exposure levels and cultivat-

ing the microbes found in the swabs, Kiiskinen determined the relative amount

of microbes that had been eliminated due to exposure at proper wavelengths of

UV light.

According to Kiiskinen, the underlying mechanism is the absorption of UV

radiation in the DNA molecules of a microbe or virus. This happens when a DNA

molecule is struck by a photon with a certain energy. The photon is absorbed

and will either cause heating or the DNA molecule to reach a higher energy level

causing a bond to break. The breaking of the DNA molecular bond will lead to

inability to reproduce additional microbes or viruses.[1]

Kiiskinen found that 5 minutes of irradiation under a UV-C lamp was suffi-

cient to disable 100% of E. Coli bacteria in both surgical and FFP2 type masks,
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within measurement accuracy. Similarly with MS2 virus, a 30-minute irradiation

was enough to kill all of the viruses in the surgical mask but not enough to kill

everything in the FFP2 mask. According to Kiiskinen, this is caused by the

denser structure of the FFP2 mask. [5]

Kiiskinen explains that several factors are relevant when measuring the UV

absorption in face masks. For example copper, which can be found in some

antimicrobial face masks, absorbs UV radiation remarkably well. Other factors

come from the practical use of a face mask. Sun-blocking lotions are designed to

prevent harmful wavelengths of UV radiation from penetrating into the human

skin. The same wavelengths of UV light are used to eliminate microbes. This

means that if a face mask is contaminated with sun-blocking lotions, the dosage of

UV radiation has to be adjusted. Similar effects were found with various cosmetic

make-up products.[1]

2 Methods

2.1 Optical Characterisation

Using two separate measurement tools, OceanOptics2000+ and Cary5000, the

reflection and transmission of a set of selected UV wavelengths have been meas-

ured for three different mask types (Surgical, FFP2, Reusable Textile Mask). The

measurement setup consists of a lamp that produces light which, in the case of

the Cary5000, is passed through a monochromator which is then passed through

the face mask for transmission studies and pointed at the face mask for reflection

studies. The light is then collected with an integrating sphere into a detector. By

measuring several different wavelengths, and then by comparing the signal level

to the reference, one can obtain a good result of the transmission and reflection

at different wavelengths.

The reference level is set by measuring a linear 100% reflectance using a

reference standard Lambertian reflector and a 0% reflectance by blocking any

light from passing from the light source to the detector. The 0% reflectance is

required to correct for dark level or non-zero background noise in the detector.

The reference level for transmittance is obtained in a similar fashion as for the
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0% level; the light is blocked from passing through, but it differs from reflectance

in that the white reflector is not needed for transmittance. The light is allowed

to pass through entirely into the integrating sphere and then to the detector. [6]

The difference between the two tools that were used is that the Cary5000

uses a monochromator to select which wavelength of light to pass through to

the sample. This means that there is less noise from effects such as fluorescence.

The Cary5000 instrument also collects the light using an integrating sphere and a

photodetector. That is opposed to OceanOptics2000+ which passes through the

entire spectrum of the emitting lamp to the sample and measures the intensity of

these wavelengths using a CCD detector array. [6] The OceanOptics2000+ was

used to obtain a spectra of the face mask transmittance and reflectance including

all side effects such as fluorescence. Measuring such effects results in a better

understanding of the material and the behaviour of it in non-monochromatic

light.

2.2 X-ray tomography

X-ray tomography works by imaging an object one slice at a time. It relies on

X-rays to measure the attenuation of the rays through an object. The attenuation

of the object is measured from multiple angles. Each angle will result in an atten-

uation curve, which describes the amount of x-rays being absorbed in the sample.

When all angles have been imaged, the data can be stored in a sinogram. The

sinogram is built such that the data from angle 0 is in the middle of the sinogram

and the 50th angle measured is at the 50th column in the sinogram. The data in

the sinogram data is filtered in either Fourier, Radon or spatial domain to remove

fuzziness in the final image. Once the filtering has been done a back projection

can be performed to recreate the CT image of the object. Back projections work

by taking the data in the sinogram columnwise and projecting it back over an

empty image. The resulting image will be a cross-sectional representation of the

object and therefore the imaging needs to repeated at different levels. All the

images are then placed into a TIF stack which holds all cross-sectional images in

one file.
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Figure 1: Example of the process of tomographic imaging and image reconstruc-
tion on a sample picture of a human head. [7]

Figure 1 shows the process of obtaining tomographic images. The sample

image of the human head is used, as the resulting sinogram and image are easier to

see than with a face mask structure. The sample is first imaged at multiple angles

to create attenuation curves, which are stored in a sinogram. The sinogram data

is used in filtered backprojection to create a cross-sectional image of the sample.

[8]

2.3 Numerical Simulations

The numerical simulations are completed using TracePro, a ray tracing software

which allows user-defined properties in materials. This is important since the

extinction coefficient is unknown for polypropylene and has to be fit to the model

within the software.[9]

Ray tracing is used in several applications, ranging from 3D graphics to

defining material properties through simulations. In this thesis, I use ray tracing

to determine properties of textile materials. The method in question is forward

ray tracing opposed to reverse ray tracing, which is used in video games.

Forward ray tracing is based on following the path of a ray of light and

applying properties of the materials in which the ray is reflected, refracted and

diffracted. Each reflection, refraction and diffraction event creates a new number

of light rays with new properties such as intensity, wavelength, phase or angular

polarisation. The angular distribution of diffraction from a surface can be defined
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to match the real world material properties.[9]

TracePro uses Monte Carlo ray tracing to simulate scattering and diffraction.

This means that it can be regarded as a statistical process which will come closer

to the correct result when more rays are being applied. TracePro also uses a

variance reduction technique that will reduce the number of rays needed to obtain

an accurate result.[9]

Ray tracing in itself does not solve Maxwell’s equations, as it only relies on

classical optics theory to solve problems. This means that effects that rely on

the wave-like nature of light cannot be solved using ray tracing, but as described

above, such effects at interfaces and surfaces are included phenomenologically.

[10] In our case, this is not an issue since all fibres and structures are around an

order of magnitude larger than the wavelength of applied light. The wavelength

of focus is in the UV range of light, which is around 200-450 nm, whereas the

smallest possible structure in these models is around 4000 nm.

The lower limiting factor on structure size comes from how the mask struc-

tures have been imaged. The x-ray tomography creates a stack of images which

will be placed at certain intervals in 3D space to create a model based on which

pixels in an image contain material and which do not. The pixels become voxels

when converted into 3D space. A voxel is essentially a cube which can either

contain material or not. The voxels in each mask image are around 4000 nm;

therefore, the smallest possible structure is a single voxel.

The theory behind ray tracing is based on classical optics theory including

Snell’s law and Fresnel’s equations. [10] These equations can be derived and can

be found in appendix A.

Within Tracepro, a number of tools are used to obtain data. Most of them are

self-explanatory. Volume Flux is one of the tools that need further discussion.

Volume Flux allows the user to specify cuboids in space. After a ray tracing

simulation is done, the cuboids are used as volume elements to collect flux data.

Data that the tool collects includes incident flux, originating flux, absorbed flux

and lost flux. [9]

For the purpose of this thesis, absorbed flux is used. Absorbed flux calculates

the amount of light absorbed inside the volume element. This is a better option
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than incident flux, since incident flux only calculates the sum of light passing

through the edges of the cuboid bounding the volume and can, therefore, calculate

the same ray twice. This happens if the ray passing through a volume element is

reflected back towards the source, causing the total flux inside a volume element

to be over 100%. Absorbed flux is used instead, as it only calculates the amount

of light absorbed inside a volume element. We can obtain an absorption profile

for the light by calculating

Ln = 1 + Σn
i=1(−ai) (1)

where Ln is the remaining light after the nth volume element and an is the ab-

sorption in the nth volume element. The absorption profile is of great interest, as

it describes the depth at which light is being absorbed and, therefore, travelling

through the face mask material. Incident flux measures light travelling through

air and can therefore give a false measurement.

3 Material structures

The physical properties of the textiles under study are key in obtaining accurate

simulation results. Optical properties such as refractive index and absorption

coefficient, in particular, are of uttermost importance. In some cases, surface

scattering properties can play a role for accuracy of simulation results.

3.1 Surgical mask

Figure 2: Skin-friendly layer (left), Filter layer (middle), Protective layer (right)
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Single-use surgical face masks usually consist of three layers, all containing melt-

blown polypropylene fibres. The middle layer works as the filter and is usually

denser than the outer layers, which are usually manufactured with lighter fabric

than the middle layer. [3] The outer layers serve the purpose of giving a soft

feeling against the skin of the user and trapping dirt. The difference in textile

density can be seen in figures 2, 3 and 4. [11] The non-woven structure of the

single-use face masks gives them a great amount of randomness in the structure.

Some parts may be entirely closed off by solid blocks of melted polymers while

holes exist at other spots, as can be seen in figures 3a and 3b.

The refractive index for bulk polypropylene is found in literature to be nPP =

1.49 [12] for some parts of the spectra whereas others claim as high as npp = 1.85

for wavelengths in the UV range. [13] The extinction coefficient kpp is found to

be very low or zero for most of the UV spectra, only to rise to a value of 10−4

between 250 and 300 nm. [13]

(a) All layers of a surgical mask (b) Top layer, surgical mask

Figure 3: Layers of a surgical mask, imaged using x-ray tomography
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(a) Middle layer, surgical mask, zoomed (b) Middle layer, surgical mask. Area en-
closed in red is shown in fig. 4a

Figure 4: Middle layer of a surgical face mask, imaged using x-ray tomography.
Fig 4a shows a blowup of the fibre structure and fig 4b shows the complete
structure. Fig 4b is of size 2.174 mm x 2.617 mm

The randomness of the non-woven structure is visible in figures 3 and 4. The

charged finer middle layer (fig. 4) blocks microbes and viruses effectively, whereas

the movement of larger aerosol droplets are stopped already by the outer layers

(fig. 3).[11] In figure 3, the solid blocks of melted polypropylene can be seen as

green spots.

3.2 FFP2 mask

Similarly to the surgical mask, the FFP2 mask consists of non-woven materials

which are usually melt-blown into a fabric. The difference is that the middle

layer of an FFP2 mask is denser and thicker. In figure 5, it can be seen that there

are technically three layers in an FFP2 mask, but the top layer is much thicker

and denser than what was seen in the surgical mask. According to standards,

the FFP2 mask has to filter at least 94% of airborne particles with at most 8%

of inward air leakage. Inward leaking air is the total amount of contaminated air

that passes through a mask in the reverse direction, i.e. inward. This can happen

at interfaces between the seal and a user’s skin or through the filter material. [14]

Polypropylene seems to be the main component of FFP2 masks as well.
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Figure 5: Layers of an FFP mask. Imaged using x-ray tomography

3.3 Reusable textile mask

The reusable textile mask differs from the surgical mask and the FFP2 mask

substantially. The other two face masks consist of non-woven textiles, whereas

the reusable textile mask consists of woven textiles. This results in a much more

consistent and periodic material for the textile mask, with fewer irregularities

in the structure. However, the textile fibres are usually thicker than the fibres

in surgical and FFP2 masks, which also leads to a larger mean pore size in the

textile masks. When it comes to the materials used in the reusable textile mask,

it differs from the other options as it contains nylon, cotton and other compounds

not found in the single-use face masks. In figure 6, the left most layer can be seen

as an almost solid thin sheet. That layer is the polyester layer which is located

furthest out in the mask.
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Figure 6: Layers of a textile mask, model CV34

4 Workflow

4.1 Creating the face mask model

In this section the workflow that was found to be most optimal will be briefly

explained. More details of the workflow can be found in appendix B.

The x-ray tomography gives a stack of TIF images which need to be ma-

nipulated to be usable in a 3D model. First, ImageJ FIJI was used to crop the

image, split the stack into multiple parts, make the stack binary and convert the

stack into a 3D surface mesh (*.STL). The surface mesh was then imported into

MeshLab where a smoothing filter called Laplacian smooth (surface preserving)

was used to smooth out any odd parts which were left by ImageJ FIJI.
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Figure 7: Principle of Laplacian smooth on a 2-dimensional mesh

Laplacian smooth works by moving a vertex point to the average position of its

neighboring vertices. The new position for a vertex i is then given by

[x, y, z]i =
1

N

N∑︂
j=1

[x, y, z]j (2)

if it has N neighbors. [15] [16]

The surface mesh was then imported into Fusion 360 where it was repaired,

converted into a solid object and filled. Afterwards the model was exported in

ACIS format (.SAT). The model was then imported into TracePro where it was

scaled to match the actual size of the fibres and a simulation setup was built

around it, in accordance with the illustration in figure 8. Appendix B shows a

detailed guide of recreating the model such that the simulations can be repeated.
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4.2 Simulation setup

Figure 8: Illustration of the simulation setup, side view

1. Light source (Blue)

2. Sample structure, face mask (Green)

3. Closed box, perfect absorber (Blue)

4. Rays (Orange)

The simulation setup consists of a ray source to simulate the lamp, which can be

seen to the right in figure 8, the face mask structure, seen as green in the middle

of figure 8, and two boxes with the material property of perfect absorber. The

entire setup is enclosed between the two boxes, so that the only way for light to

pass through from the right box to the left is through the sample. Any rays that

are absorbed in the left box have been transmitted through the sample and any

rays being absorbed in the right box have been reflected. The creation of the

simulation setup is discussed in more detail with a complete guide in appendix

B.
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5 Results

5.1 Experimental results

Figure 9: Single use surgical mask, model SMDP20603, 100%-reflectance (R) and
transmittance (T). Normalised measurement units (% of light from perfect white
reflector used to calibrate measurement device for reflection studies or unobstruc-
ted incident light for transmission studies.)

Figure 9 shows the reflectance and transmittance of a surgical single-use face

mask, measured on two different devices. The lower part of the spectrum, below

350 nm, is poorly transmitted and poorly reflected. This shows that the absorb-

ance can be expected to be high in this region of the spectrum. The reflectance

has been chosen to be represented as 100% minus reflectance. That way the

space between the transmission curve and the 100% minus reflectance curve is

the absorptance.

Due to colouring and bleachers used when manufacturing a mask, the op-

tical characterisation of a face mask in a simulation program becomes difficult.

Therefore, it is optimal to try to isolate the properties caused by bleachers and

colouring. In an attempt to do this, a surgical mask consisting of three layers of

melt-blown polypropylene has been dissected and the layers were separated. The

outer layers of the face mask are coloured whereas the middle layer, which is not
14



visible to the user, is less likely to contain colouring. The same reflectance and

transmittance measurements were performed on this structure.

Figure 10: Surgical mask middle layer, reflectance (R) and transmittance (T)
measured on Cary5000. Absorption is calculated as 100% − R − T . Normalised
measurement units to perfect white reflector or perfect transmittance.

As shown in figure 10, the middle layer has constant reflectance and transmit-

tance above 300 nm. There is an absorption peak between 260 nm and 280 nm.

The absorption goes below zero for wavelengths above 290 nm due to minor calib-

ration issues in the measurement device, but has been set to zero when comparing

to simulations. This property helps the characterisation of the optical properties

later on as fitting the optical parameters becomes easier. Specifically the absorp-

tion coefficient can be set to zero at higher wavelengths, which only leaves the

refractive index to be fitted such that simulations agree with measurements.
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Figure 11: FFP2 mask, model M9502, 100%-reflectance (R) and transmittance
(T). Normalised measurement units to perfect white reflector or perfect trans-
mittance.

The FFP2 mask is quite reflective for most parts of the spectrum, specifically

above 400 nm. This is to be expected due to the white colour of the face mask and

the dense structure of the outer layers of the mask. The mask is very absorbent

below 400 nm as almost no light is transmitted, whereas only 20% is reflected.

This is caused by a chemical whitener used to create the white colour of the face

mask.
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Figure 12: Textile mask, model CV34, consisting of woven material, 100%-
reflectance (R) and transmittance (T). Normalised measurement units to 100%
reflectance of perfect white reflector and perfect transmittance.

The textile mask does not reflect nor transmit significant amounts of light between

200 and 300 nm. The reflectance starts rising after 300 nm, whereas the trans-

mittance spikes up after 400 nm. This is an effect caused by a process of optical

whitening of the fabric. The use of optical brighteners and whiteners give the fab-

ric a white-looking surface due to fluorescence causing the fabric to absorb light

very well below 400 nm. The light is then emitted with a uniform distribution in

all directions, causing the peak at approximately 450 nm in the OceanOptics tool.

[17] The peak is not visible in the Cary5000, since the light is passed through a

monochromator both on the path to the mask and on the path to the detector.

Therefore there is no lower wavelength light to absorb and no emission at 450

nm. Another factor that comes into play is that the top layer of this particular

face mask is composed of polyester, which contains phenyl esters. Phenyl esters

are excellent at absorbing UV light below 310 nm. [1]
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Figure 13: Estimate of absorbance using 100%-R-T, normalised units to 100%
reflectance of perfect white reflector and perfect transmission

One can estimate the absorbance of a sample by using

A = 100%−R− T (3)

where A is absorbance, R is reflectance and T is transmission. Figure 13 shows

and absorbance estimate obtained using equation 3. Note the difference in es-

timated absorption between the two tools for the reusable textile mask, which is

caused by the fluorescence only visible with the OceanOptics tool.

5.2 Validation of simulation principle

To verify the results of the completed simulations, one needs to find a way to con-

firm that the simulation will give the same results as a verified theory. A Matlab

script [18] was used to calculate the reflection, transmission and absorbance of

light through a bulk material. The script mimics light being transmitted through

a piece of material that is placed in air. The light travels through two interfaces,

from air to material and from material to air. In the case of the surgical mask,
18



the material is given the same complex refractive index as for polypropylene.

The Matlab script then applies Fresnel’s equation and the Beer-Lambert model

to calculate reflection, transmission and absorbance. [18]

Fresnel’s equations can be derived from the boundary condition of an elec-

tromagnetic field being transmitted and reflected off of a surface.

This same setup is completed in TracePro to verify that the results, in fact,

are the same. By comparing several different coefficients of extinction, i.e. the

imaginary part of the refractive index, one can see if the results match between

simulations and a widely accepted optical model.

Figure 14: Comparison of results from simulations and theoretical description
k = 1.36 · 10−6, n = 1.49

The simulations were completed first with a 2 mm thick block of polypropylene

and the refractive index was set to 1.49 + 1.36 · 10−6i. The results were very

similar and match down to the fourth decimal point. When the complex part of

the refractive index is set to zero, the wavelength dependence disappears, as is

shown in figure 15
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Figure 15: Comparison of results from simulations and theoretical description
k = 0, n = 1.49

By observing the graphs, one can see that the wavelength dependence has van-

ished when setting the imaginary part of the refractive index equal to zero. As

one can expect, when setting the coefficient of extinction to zero, there is no ab-

sorption visible in figure 15, unlike in figure 14. This shows that the simulations

and the results given from those can be trusted to give a correct result.

Another way to validate the use of TracePro and the related settings is to

measure how many rays are required to obtain a steady-state result, results of

which can be seen in table 1. This validation is performed by running simulations

with a varying number of rays until there is no change in the result except for

statistical variance, starting out with 1 ray and then moving up to 10, then 100

and so on. This test is first performed with ray splitting set to 0.
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Table 1: Transmission and reflectance simulated with varying number of rays on
face mask model

# of rays 1 10 100 1000 5000

Transmission 0.051 0.026 0.046 0.047 0.054

Reflectance 0 0.124 0.147 0.172 0.152

# of rays 10000 15000 30000 50000

Transmission 0.056 0.052 0.052 0.052

Reflectance 0.174 0.156 0.156 0.156

Another way to validate the setup is to vary the cross-sectional size of the sample.

With the surgical mask, the sample was originally cropped to 249x249 voxels in

cross section. Then by scaling the bounding box in the simulation setup, the

cross section can be reduced. This results in the following table:

Table 2: Transmission and reflectance simulated with varying cross-sectional area

Scale Factor 1.0 0.8 0.5 0.4 0.3 0.1

Transmission 0.052 0.050 0.048 0.049 0.037 0.022

Reflectance 0.156 0.151 0.153 0.168 0.175 0.248

By looking at this table, one can see that the difference between scale factor 1

(i.e. 249x249 voxels cross section) and scale factor 0.5 is minimal. This indicates

that, indeed, a steady-state result has been achieved at 249x249 voxels. All of

these simulations were run at 300 nm wavelength.

5.3 Fitting of parameters

Results are extracted from the simulation software using several software tools

built into Tracepro. One result that of great interest is the reflection and trans-

mission values for simulations. They can be obtained by looking at the amount

of light absorbed by the boxes that bound the simulation, as seen in figure 8.

These values are used to define parameters such as the absorption index and the

refractive index. From the data in figure 10, we can see that the surgical face

mask is mostly reflective at higher wavelengths. Therefore, a wavelength of 450

nm was used to find the value of the refractive index as the extinction coefficient
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k is very close to zero. Several simulations were performed to find that the reflec-

tion and transmission values are highly independent on the value of the refractive

index, as can be seen in table 3.

Table 3: Reflection and Transmittance over refractive index at 450 nm

n 1.95 2.05 2.25 2.5 3.0 4.0 5.0

R 0.648 0.657 0.681 0.681 0.683 0.691 0.721

T 0.352 0.343 0.319 0.319 0.317 0.301 0.279

Since the variance over refractive index is very small, the value found in literature

of 1.9 was chosen as the base for the simulations. [13] The simulations were

performed at 280 nm, as this wavelength is where UV radiation is most effective

at disabling microbes. [5] The aim of the simulations then were to match the

absorbed radiation dose with that of the optical measurements. From figure 10,

we can see that absorption should be around 10% at 280 nm, whereas reflectance

and transmittance should be around 65% and 25% respectively. In table 4, the

best fit is obtained with a k-value of 4 · 10−6 when compared to figure 10. This

is the most important parameter that sets the absorption level of a face mask.

Table 4: Reflectance, transmission and absorptance estimates at 280 nm, n=1.9

k 8e-7 2e-6 4e-6 5e-6 8e-6 2e-5

R 0.621 0.606 0.581 0.570 0.539 0.445

T 0.359 0.347 0.329 0.343 0.298 0.231

A 0.019 0.047 0.090 0.109 0.164 0.325

The reflectance and transmittance cannot be matched perfectly with the

optical measurements, as the refractive index n is fixed. It is safe to assume that

the results would be closer to the measured values if not for limitations in the

workflow and how accurately the structure can be described in the simulations.

The x-ray tomography images restrict the shapes of face mask fibres into polygon-

shaped surfaces when being converted into surface mesh data.

22



(a) Attenuation of light (b) Absorption in volume

Figure 16: Attenuation light as a function of depth (calculated using equation 1)
and absorbed light inside the model divided into volumes with thickness 0.0106
mm, simulated at 280 nm using n = 1.9 and k = 4 · 10−6. Data can be found in
appendix C

Figure 16 shows that absorption happens throughout the thickness of the

face mask middle layer.

5.4 Simulation of a complete face mask structure

Simulations were then performed on all three layers of the surgical mask model

using the values found earlier (n = 1.9 and k = 4 · 10−6). The absorption is

found to be much lower than that of the experiments. This can be caused by

optical modifying agents like bleachers or colours in the material that increase

the absorption in the two outside layers. For the surgical mask, the simulated

attenuation is shown in figure 17
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Figure 17: Absorption (A) of light inside a surgical mask using k = 4 · 10−6 and
n = 1.9 at 280 nm. Distance is measured from origin. The absorption curve has
been calculated using equation 1. There were 1000 sample slices with thickness
of 0.00187 mm.

One can clearly see three distinct drops in remaining light. Each drop corresponds

to a layer in the face mask. The light is absorbed in every part of the face mask.

For the middle layer the drop is slightly smaller than in the simulations shown in

figure 16a, where only the middle layer was included. For the complete structure,

the simulated absorption of 13% is significantly smaller than the measured level

of 50% shown in figure 9. Reflection and transmission was simulated to be 65

% and 22% respectively. That means that a lower refractive index and higher

extinction coefficient would be needed to meet the results found experimentally in

figure 9. The reason may be the enhanced absorption and decreased reflectivity

of the face mask materials caused by colouring of the outer layers, especially the

blue layer shown in figure 2.
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6 Conclusions

Based on the results obtained in this thesis, we can conclude that optical char-

acterisation of face masks is feasible using forward ray tracing. The results are

highly dependent on the number of rays and the size of the sample. Other factors

are important to take into account when attempting to do a simulation of face

masks using TracePro. TracePro will require great amounts of computational

power and RAM to be able to perform the simulations. The requirement in-

creases with model detail and the amount of rays being used.

The workflow is an entirely new way to convert TIF stacks to ACIS files.

By doing this sort of conversion, one can not only produce 3D models for optical

characterisation but for other physics simulations as well.

The results shown in figure 16 and 17 together with data in tables 3 and

4 speak for the possibility of full face mask decontamination using UV light.

The light penetrates through the densest layers of the face mask evenly, with

high levels of reflection. Since the microbe will be on the surface of the fibres of

the face mask, the reflections caused by the material plays an important role in

decontamination. As light is reflected in the face mask, there is a greater chance

of light striking the DNA of the microbe and, therefore, disabling it.
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A Appendix: Derivation of Fresnel’s equations

Figure 18: Reflection and refraction of an electromagnetic wave

Starting with an incident electromagnetic wave described by

Ei = Ei0e
iki·x−iωt (4)

Bi = ni
ki × Ei

k
(5)

and for the refracted wave

Et = Et0e
iktx−iωt (6)

Bt = nt
kt × Et

kt
(7)

and for the reflected wave

Er = Er0e
ikrx−iωt (8)

Br = nr
kr × Er

kr
(9)

Since ki · x = kr · x = kt · x at z = 0, ni = nr, θi = θr and ki = kr, combining the

equations above results in a boundary condition:

Ei + Er = Et (10)

26



Bi cos θi −Br cos θi = Bt cos θt (11)

By substituting equations 5, 7 and 9 into equation 11 and simplifying the vector

product, one will arrive at

niEi cos θi − niEr cos θi = ntEt cos θt. (12)

By factoring the left hand side and substituting Et with equation 10, the following

equation is formed:

ni cos θi(Ei − Er) = nt cos θt(Ei + Er). (13)

Then by expanding the brackets

Eini cos θi − Erni cos θi = Eint cos θt + Ernt cos θt, (14)

and factoring the equation with respect to Er and Ei, one arrives at the following

equation:

Ei(ni cos θi − nt cos θt) = Er(ni cos θi + nt cos θt). (15)

Through some manipulation on both sides of the equation, we arrive at

Er

Ei

=
ni cos θi − nt cos θt
ni cos θi + nt cos θt

, (16)

hereby named rs. Then continuing with equation 12 and 10, we can write

niEi cos θi − niEt cos θi + niEi cos θi = ntEt cos θt. (17)

which can be written as

2niEi cos θi = Et(nt cos θt + ni cos θi), (18)

and from there, it can be written as

Et

Ei

=
2ni cos θi

nt cos θt + ni cos θi
, (19)
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hereby named ts. Equations 16 and 19 are called Fresnel’s equations for s-

polarised light. To derive Fresnel’s equations for p-polarised light, we start with

the boundary conditions

Ei cos θi + Er cos θr = Et cos θt (20)

Bi −Br = Bt. (21)

By using equations 5, 7 and 9, we can write equation 21 as

niEi − nrEr = ntEt, (22)

which is the same as

niEi − niEr = ntEt, (23)

because ni = nr. Through factorisation and dividing both sides with nt, we arrive

at

Et =
ni

nt

(Ei − Er). (24)

This can be substituted into equation 20 to get

Ei cos θi + Er cos θr =
ni

nt

(Ei − Er) cos θt. (25)

Since θi = θr the equation above will become

ntEi cos θi + ntEr cos θr = niEi cos θt − niEr cos θt. (26)

Through factorisation this becomes

Ei(nt cos θi − ni cos θt) = Er(−nt cos θr − ni cos θt) (27)

and then
Er

Ei

=
ni cos θt − nt cos θr
nt cos θi + ni cos θt

, (28)
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hereby named rp. From equation 23 we can obtain

Er =
nt

ni

Ei − Et. (29)

Using this in equation 20 we obtain

Ei cos θi + (Ei −
nt

ni

Et) cos θr = Et cos θt. (30)

Simplifying the parenthesis and multiplying the entire equation with ni results in

2niEi cos θi = niEt cos θt + ntEt cos θi (31)

By factoring the equation above, we obtain

Ei(2nicos θi) = Et(ni cos θt + nt cos θi) (32)

Et

Ei

=
2nicos θi

ni cos θt + nt cos θi
(33)

hereby named tp. [19]
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B Appendix: Data collection and detailed work-

flow

This section is intended to be a guide for replicating the simulations performed

in this thesis. To replicate the simulations performed in this thesis, one will need

software to help convert the X-ray CT into a 3D model. The minimum amount

of software needed is ImageJ FIJI, Fusion 360 (or other similar CAD program)

and TracePro. The workflow starts by importing the TIF stack of images given

from the X-ray CT into ImageJ FIJI. Inside ImageJ FIJI, one should limit the

model size using tools such as crop to limit the width or using the slice toolbox

to remove certain slice of the TIF stack. Crop can be accessed by first selecting

a rectangular area with the rectangle tool and then Image → Crop. The slice

toolbox can be accessed through Image → Stacks → Tools from which one can

choose one of several options. In this thesis, Slice Keeper was used to select

which slices of the image to keep.

Once this is done, one should convert the TIF stack into binary such that

there can only be white and black pixels in the image. This can be done through

Process → Binary → Make Binary. The TIF stack is now ready to be turned

into a surface mesh, i.e. an STL file. This can be done through Plugins → 3D

viewer, which will open a new window, seen in figure 19, in which one should

confirm that the correct image is selected through observing the name in the top

and then setting the option Display as to Surface instead of Volume.
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Figure 19: 3D viewer options window

If the model is complex and large, the computer might need a minute or two

to process the conversion. Once it has completed, there should be a window open

showing the 3D model of the TIF stack after it has been converted into a 3D

model. Then one should export the surface into an STL file, which can be done

through File → Export surfaces → STL (binary)

Once the STL file has been obtained, one can move on to working in Fusion

360 or another CAD program. Within Fusion 360, one should first import the

STL file into the software. After that one should check that all surfaces are closed

off such that there are no bodies that have holes in them. Start by selecting Mesh

→ Prepare → Repair after which a new window will open up promtping to

select Body. One should select the imported mesh. Then one should proceed to

changing Repair type to Wrap. Once this operation is completed, one should

move on to Mesh → Modify → Convert Mesh which will again open a new

window in which one should select the body of the STL mesh and leave other

options on default. After this operation, the mesh will have been converted into

a solid 3D object but, unfortunately, the edges are infinitesimally thin. To fix

this one has to use Solid → Create → Boundary fill. In the new window,

one should select all the objects created in the previous step. This is easiest

by just holding the left mouse button and dragging a selection over all tools.
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This usually takes a while and the software can be expected to be unresponsive

on several occasions. The same procedure should be repeated after clicking on

Select cells. Under Operation one should choose New body, if not already

selected by default and then Remove Tools should be selected under it.

(a) Repair mesh body
(b) Boundary fill

Figure 20: The pop-up windows want you to select body, tools or cells. This is
easiest through click and hold then dragging the cursor to select all

Figure 21: View in Fusion 360, Tabs marked in red on top and pop-up window
for Boundary Fill marked in red on the right

When all steps have been completed inside Fusion 360 one can proceed to

exporting the file by clicking File → Export and then in the new window, giving

a name to the file and under Type selecting SAT files (*.sat). The resulting

window should look like
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Figure 22: Export settings in Fusion 360

Once the file has been converted into SAT, one can move on to working in

TracePro. In TracePro, one should import the SAT file and work around that

one. A general tip is to save the file after importing the SAT file, so that the

conversion does not need to be redone in case of a crash. After the file is saved

as a *.omlb file, one can select all the objects in the file tree and then press

Edit → Boolean → Unite to unite all the objects into one. Failing to do this

step will result in overlapping surfaces which TracePro is not equipped to handle.

Once the unification is done, one can proceed to scaling the object by selecting

the object in the object tree and then clicking Edit → Scale and then applying

the scale factor in the pop-up window. The scale factor, α, can be calculated

using

α =
nvoxdvox
dmodel

, (34)

where nvox is the number of voxels along a certain dimension, dvox is the size of

the voxels in that direction and dmodel is the size of the 3D model inside TracePro.

Then one can proceed to building the simulation setup in TracePro. First

of all, one should select the view type desired. For the purpose of this thesis, I

used Wireframe since it gives a good idea of the three-dimensional view of the

object while displaying everything, including objects behind other objects. Then

one should continue by placing a hollow cuboid over the sample model. A hollow

cuboid is easy to achieve by placing a block that covers the entire sample model
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and then placing a slightly narrower but equally long block inside of the first one.

Then, by first selecting the larger block and while holding the ctrl button, select

the second block. Then by proceeding to press Edit → Boolean → Subtract,

one should have a cuboid that is open in both of the ends. It is imperative that

the ends of the cuboid be left open so the light has a way of entering the sample

model. The cuboid is hereby referred to as bounding box.

One should then continue by placing larger hollow cubes on each end of the

cuboid that was just created. The faces of the cube facing the sample model

should be removed so as not to interfere with the simulations. TracePro is unable

to simulate rays that go through two different materials at once. The cubes are

hereby referred to as Transmission and Reflectance depending on which end

of the simulation setup it is. Finally, one can place the light source. The light

source should be a cuboid, as well, with width and height slightly narrower than

what the sample is. That way all the rays leaving the light source will initially

hit a part of the sample instead of an artificial structure. The simulation setup

should be something similar to what can be seen in figure 8.

The simulation setup is almost complete, as the only step left is to ensure

that the simulation parameters are correct and that all material properties are

applied. First, one should start by selecting the sample model and clicking Right-

click → Properties → Material properties and, from there, select and apply

the material property wanted. One cal alternatively proceed by creating a new

material property by clicking View data and follow the steps in the pop-up win-

dow to create a new material property. One should then apply surface properties

Perfect mirror to the bounding box in the Surface properties tab, Perfect

absorber to the cubes Reflection and Transmission.

The Light source does not need a material or surface property; instead,

one should apply a Surface source property to it. This can be done in the same

properties windows as the previous properties applied. The surface source needs

to be applied only on one of the surfaces of the source and not the entire surface.

Therefore, one needs to open the object in the object tree to reveal the surfaces.

Select the surface that is pointing towards the sample model. In the surface

source tab under properties, apply the following modifications: set Angular
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distribution to Normal to surface, Emission type to Flux and Units to

Radiometric. Then specify the number of rays needed in the calculation and

then add one or more wavelengths to the list to be simulated.

Next follows the adjustment of the ray-tracing settings. The settings can

be found in Raytrace → Options there one should choose appropriate settings

to match the simulations to be done. In this thesis, we have disabled the ray-

splitting option, as it will cause the number of rays to grow exponentially and fill

all available memory.

Figure 23: Wireframe view of simulation setup. From the left: 1. Reflection
measurement box (green) 2. Light source (green) 3. Mirror tube (green) 4. Face
mask model (grey) 5. Transmission measurement box (green)
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Figure 24: Properties window (Materials, Surface and Surface Source can be
selected on the left)

Once the simulations are done, one can view transmission and reflection

results by clicking Reports → Flux. To obtain volume flux data, one needs to

click Tools → Collect volume flux and specify the boundaries for the volume

flux data acquisition. This is done by defining two corners of a cuboid and then

specifying the number of volumes the cuboid should be split into in each direction.

The tool will write a .txt file which contains data acquired with the volume flux

tool. An example of such data can be found in appendix C.

36



C Appendix: Absorbed flux data

Table 5: Volume Flux data, n=1.9, k=4e-6, λ=280 nm

Z Center Incident Flux Absorbed Flux 1-Absorbed (eq. 1)
0.1453 1.57718462 0 1
0.1559 1.58779743 0 1
0.1665 1.58930926 0 1
0.1771 1.58664523 0 1
0.1877 1.5884239 1.85E-06 0.999998149
0.1983 1.59024651 1.87E-05 0.999979474
0.2089 1.59209401 1.01E-05 0.999969381
0.2195 1.59030121 2.24E-05 0.999947017
0.2301 1.59214218 2.43E-05 0.999922692
0.2407 1.59522586 2.86E-05 0.999894046
0.2513 1.59785778 4.88E-05 0.999845244
0.2619 1.60100414 6.06E-05 0.999784632
0.2725 1.63304425 0.000184456 0.999600176
0.2831 1.69653319 0.000463708 0.999136469
0.2937 1.80308908 0.000951712 0.998184756
0.3043 1.96896525 0.001903025 0.996281731
0.3149 2.05818732 0.002308227 0.993973504
0.3255 2.01231475 0.002032271 0.991941234
0.3361 1.96486751 0.001817654 0.990123579
0.3467 1.94280491 0.0016774 0.988446179
0.3573 1.88973024 0.001806513 0.986639667
0.3679 1.83993514 0.001281784 0.985357883
0.3785 1.79128532 0.000973372 0.984384511
0.3891 1.77907162 0.001148054 0.983236457
0.3997 1.86265242 0.001680244 0.981556212
0.4103 1.97567675 0.002114173 0.97944204
0.4209 2.01226093 0.002689872 0.976752167
0.4315 1.96830933 0.002502542 0.974249626
0.4421 1.91202663 0.002205574 0.972044052
0.4527 1.846233 0.001979104 0.970064948
0.4633 1.82801749 0.002040473 0.968024475
0.4739 1.88649298 0.002355741 0.965668734
0.4845 1.88051182 0.002473352 0.963195382
0.4951 1.77280379 0.002158335 0.961037046
0.5057 1.67921657 0.001401044 0.959636002
0.5163 1.65303922 0.001459301 0.958176702
0.5269 1.66524398 0.002088027 0.956088675
0.5375 1.68464181 0.001982464 0.954106211
0.5481 1.69221944 0.00208848 0.952017731
0.5587 1.67302206 0.002538745 0.949478986
0.5693 1.6752639 0.00246311 0.947015876
0.5799 1.65308637 0.002437572 0.944578304
0.5905 1.58613637 0.002535489 0.942042815
0.6011 1.53230302 0.002347725 0.93969509
0.6117 1.47690283 0.002086125 0.937608965
0.6223 1.42032507 0.002224776 0.935384189
0.6329 1.40053726 0.002319948 0.933064241
0.5693 1.6752639 0.00246311 0.947015876
0.5799 1.65308637 0.002437572 0.944578304
0.5905 1.58613637 0.002535489 0.942042815
0.6011 1.53230302 0.002347725 0.93969509
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0.6117 1.47690283 0.002086125 0.937608965
0.6223 1.42032507 0.002224776 0.935384189
0.6329 1.40053726 0.002319948 0.933064241
0.6435 1.40681511 0.002408534 0.930655707
0.6541 1.34793457 0.002427994 0.928227713
0.6647 1.24146137 0.002088608 0.926139105
0.6753 1.18128225 0.001794863 0.924344242
0.6859 1.10203264 0.00168566 0.922658582
0.6965 1.00437236 0.001480629 0.921177953
0.7071 0.931099659 0.000971903 0.92020605
0.7177 0.863454623 0.000861844 0.919344206
0.7283 0.838356624 0.001038173 0.918306032
0.7389 0.855975025 0.001194866 0.917111166
0.7495 0.841669513 0.001325222 0.915785944
0.7601 0.778619936 0.001434765 0.914351179
0.7707 0.716716882 0.001165105 0.913186074
0.7813 0.621327673 0.000817671 0.912368402
0.7919 0.530535467 0.000590059 0.911778343
0.8025 0.483229281 0.00036081 0.911417533
0.8131 0.438404896 0.000230711 0.911186822
0.8237 0.409510145 0.000178678 0.911008143
0.8343 0.399204261 0.000168438 0.910839706
0.8449 0.388596209 0.00014635 0.910693356
0.8555 0.367496505 9.73E-05 0.910596007
0.8661 0.350373346 2.83E-06 0.910593176
0.8767 0.348131681 3.96E-06 0.91058922
0.8873 0.349669499 1.30E-05 0.910576212
0.8979 0.349023692 1.81E-05 0.910558096
0.9085 0.349448954 1.86E-05 0.910539451
0.9191 0.348950074 2.11E-05 0.910518394
0.9297 0.345895746 1.68E-05 0.910501638
0.9403 0.345305725 1.06E-05 0.910490991
0.9509 0.343239997 9.81E-06 0.910481182
0.9615 0.341614499 4.98E-06 0.910476203
0.9721 0.3422691 5.15E-06 0.910471052
0.9827 0.341386824 4.27E-06 0.910466785
0.9933 0.340570463 1.32E-05 0.910453592
1.0039 0.341597842 2.64E-05 0.910427232
1.0145 0.340798983 2.47E-05 0.910402581
1.0251 0.338365835 2.10E-05 0.910381548
1.0357 0.336140578 1.18E-05 0.910369736
1.0463 0.336616118 1.23E-05 0.910357399
1.0569 0.334565838 1.26E-05 0.91034484
1.0675 0.332149356 1.06E-05 0.910334232
1.0781 0.331404927 2.83E-06 0.910331397
1.0887 0.330335326 0 0.910331397
1.0993 0.330053439 0 0.910331397
1.1099 0.330567005 0 0.910331397
1.1205 0.330273082 0 0.910331397
1.1311 0.330275602 0 0.910331397
1.1417 0.330086464 0 0.910331397
1.1523 0.327886706 0 0.910331397
1.1629 0.321261861 0 0.910331397
1.1735 0.313885552 0 0.910331397
1.1841 0.304430586 0 0.910331397
1.1947 0.295036747 0 0.910331397
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D Appendix: Abstrakt på svenska

I denna avhandling undersöker jag möjligheterna för att desinficera ansiktsmasker

med hjälp av UV-strålning. Undersökningen utförs genom att använda 3D-mo-

deller av ansiktsmasker som baserar sig på röntgentomografibilder. Modellerna

placeras i en virtuell mätstation där mjukvaran TracePro används för att utföra

ray tracing-simulationer vid flera olika våglängder för att karakterisera absorpt-

ion, transmission och reflektion hos ansiktsmaskerna. Simuleringarna vid 280 nm

är ytterst viktiga eftersom det är våglängden då UV-strålningen är mest skadlig

för mikrober. [1] Experimentella mätningar visar att filterskiktet i kirurgiska an-

siktsmasker är högt reflektiva vid 280 nm och endast en liten andel (ca 10%) av

ljuset absorberas i ansiktsmasken.

Simuleringarna visar att ett väldigt liknande resultat kan uppnås med ray

tracing ifall parametrarna är rätt. Refraktionsindexet väljs till 1,9 enligt litter-

aturvärden som hittades medan utrotningskoefficienten varieras till det absorb-

erade ljuset motsvarar det som experimenten har uppmätt. Då rätt utrotnings-

koefficient har hittats, beräknar mjukvaran mängden ljus som har absorberats

i ett volymelement som specifierats av användaren. Från simulationsresultaten

beräknas var i ansiktsmasken ljuset absorberas mest. Simulationerna visar att

absorptionen sker igenom hela tjockleken på ansiktsmasken. Detta indikerar att

UV-strålning med våglängden 280 nm når alla ställen i ansiktsmasken och kan

därför eliminera mikrober även inuti filtermaterialet i ansiktsmasken.

I avhandlingen har en stor del av arbetet gått ut på att utveckla ett sätt att

konvertera mellan olika filtyper av 3D-modeller. Bilderna från röntgentomografin

kommer i 8 bitars TIF-stackar. TIF-stacken beskärs och omvandlas till en binär

stack varefter den konverteras till ett ytnät av typen STL. Ytnätet importeras se-

dan till Fusion 360 där det kan konverteras till ett 3D-objekt. 3D-objekten upptar

ännu bara samma rum som ytnätet så dessa infinitessimalt tunna objekt måste

få en fylld volym på insidan. Då volymen är fylld, kan 3D-modellen exporteras i

SAT-format för att sedan bli importerad till TracePro. Inuti TracePro måste ob-

jektet göras enhetligt eftersom SAT-filen som Fusion 360 genererar består av en

stor mängd små volymer. Objektet måste även skalas så storleken blir rätt. Efter

detta byggs simulationen runt objektet och först då kan en simulation köras.

39



För att bekräfta att simulationerna ger korrekta resultat, kördes en simu-

lation bestående av ett enhetligt block. Blocket ges liknande materialegenska-

perna som polypropen. Simulationen kördes vid flera olika våglängder för att

få reflektions- och tranmissionsspektra. En liknande beräkning gjordes i matlab.

Matlabkoden använder sig av Beer-Lamberts lag samt Fresnels ekvationer för

att bestämma reflektions- och transmissionsspektra. Resultaten från Matlab och

TracePro jämfördes och det syntes att resultaten var lika.

TracePro tillåter användaren bestämma antalet ljusstrålar som skall använ-

das i simulationen, vilket betyder att man måste kontrollera att en tillräcklig

mängd strålar använts i simulationen. Ifall en otillräcklig mängd användes, skul-

le resultaten variera från simulation till simulation. Därför kördes en simulation

med varierande mängd strålar ända tills resultatet uppnådde jämnvikt. På basis

av resultaten såg det ut som att resultatet inte varierar längre efter 15 000 strålar.

En liten statistisk variation syns i tabellen även vid högre strålantal.

Tvärsnittsarean på provet måste kontrolleras. Kontrollen utfördes på ett lik-

nande sätt som den för antalet strålar. Först importerades en modell med tvär-

snittsarean 249x249 voxel2, vilket motsvarar 967,46 x 967,46 µm2. Tvärsnittsarean

minskades efter varje simulation genom att placera in block i simulationen som

skalades ner till olika storlekar. En märkbar skillnad i resultaten fås inte innan

storleken på modellen har skurits ner till 0,4 av den ursprungliga storleken.

Efter att simulationerna kontrollerades, kördes simulationer på de egentliga

modellerna som byggdes av röntgentomografibilder av ansiktsmasker. Först måste

refraktionsindexet bestämmas. Simulationerna kördes först vid 450 nm med vari-

erande refraktionsindex. Detta gjordes eftersom experimentella mätningar visade

att polypropen är mest reflektiv vid denna våglängd, det vill säga absorptionen

är väldigt liten och absorptionsindexet kan antas vara noll. Litteraturvärden för

refraktionsindexet av polypropen konstaterades vara ungefär 1,85 i UV-spektrat.

[13] Då simulationerna kördes märktes det att simulationerna krävde en orealis-

tiskt hög refraktionsindex för att uppnå samma värden av reflektion och trans-

mission som experimenten visade. Detta beror på att modelleringsverktygen som

använts i framställningen av 3D-modellen bygger upp modellen av polygoner me-

dan de verkliga fibrerna är mest runda. Rundheten hos fibrerna leder till ett
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större antal möjliga reflektionsvinklar och ökar därmed reflektionsvärdet medan

transmissionsvärden sjunker.

På grund av det overkliga refraktionsindexet, bestämdes det att simulatio-

nerna vid 280 nm skulle köras med ett värde på 1,9. I simulationerna vid 280 nm

varierades absorptionsindexet istället för refraktionsindexet. Polypropen visade

sig ha 10 % absorption vid denna våglängd, vilket utnyttjades för att kalibrera

absorptionsindexet. Då absorptionsindexet hade bestämts, mättes absorptionen i

modellen som funktion av z-avstånd från origo det vill säga djupet inuti modellen.

Resultaten visar att absorption sker genom hela djupet av modellen. Detta

betyder att ljuset når alla delar av ansiktsmasken. Därmed är det endast fråga

om dos och intensitet för att uppnå desinficering av ansiktsmasken. Orsaken till

att absorptionen används som ett mått på desinficeringen är att ifall endast den

ingående intensiteten beaktas, kan höga intensitetsnivåer uppnås i områden av

modellen där material inte finns.
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E Appendix: Abstract in English

In this thesis, I will study the feasibility of using UV light to decontaminate

face masks. The process has been experimentally proven to be possible by Titta

Kiiskinen. [1][5] In her thesis, Kiiskinen explains that the mechanism of decon-

tamination is the absorption of UV light in the microbe’s DNA. The wavelength

at which this absorption is most likely to happen is 280 nm. [1]

The simulations were performed using forward ray tracing in software called

TracePro. Ray tracing is a suitable option for optical characterisation of the face

masks as it does not solve Maxwell’s equations. It relies on classical optics theory,

such as Fresnel’s equations and the Beer-Lambert law to calculate the reflection

and refraction at a surface. [10][9]

To obtain a 3D model of the face mask structure, it was imaged using x-

ray tomography. The smallest structure in a tomographic image is a single voxel

which, in the case of the surgical face mask, has a width of approximately 3.8 µm.

There were not any issues with phenomena such as diffraction since the voxel is

around 10 times larger than the wavelength of light used in this study.

The tomographic images were obtained in a TIF stack format. This format

is comprised of several 2-dimensional images. To turn the images into a 3D model

several software was used. ImageJ Fiji was used to convert from a TIF stack to

a 3D surface mesh which was exported in STL format. Meshlab was used to

smooth out rough surfaces caused by the voxel-based TIF stack. The final step

was to convert from a surface mesh to a solid 3D object. This was done using

Fusion 360 and several tools within it. After converting the surface mesh into a

solid model, it was exported in ACIS format.

The ACIS file was loaded into TracePro and a simulation setup was built

around it. The simulation setup consists of a mirror tube, light source, reflection

and transmission boxes and the 3D model of the face mask. The mirror tube was

placed such that the edges do not touch the model. The purpose of the mirror

tube was to reflect any light escaping from the edges of the model back into the

model. By doing this, the light has to travel through the model or reflect towards

the light source. At each end of the mirror tube, there is a box. Each box has had

the perfect absorber property applied to it. When the light has escaped through
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either end of the mirror tube, it is captured by the boxes. The absorbed flux can

then be viewed to measure the reflectance and transmittance of the model.

The face masks were studied experimentally by measuring reflectance- and

transmittance spectra using OceanOptics2000+ and Cary5000 spectrophotomet-

ers. It was found that the outer layers of a surgical face mask contain whiteners

and dyes which interfere with the measurements. [17] The face mask was cut open

and the measurements were completed only on the middle layer. The absorption

was found to be zero above 300 nm which meant that the coefficient of extinction

could be set to zero.

The simulations were first performed on the middle layer of the face mask

at 450 nm with the coefficient of extinction set to zero. The refractive index

was varied over several simulations. One can see that the results are highly

independent of the refractive index and an unrealistically high refractive index

would have been needed to meet the measured reflection and transmission values.

Therefore, the value for the refractive index was chosen to be 1.9 as it was found

in the literature. [13] The same simulations were then performed at 280 nm with

a fixed refractive index and a varying coefficient of extinction. The optimal value

for the coefficient of extinction was found to be 4 · 10−6.

The complete face mask structure was then imported into TracePro and the

simulations were performed on it. The absorption profile was obtained using the

volume flux tool. We found that absorption happens throughout the entire face

mask and that there are three drops in the remaining light. Each of the drops

corresponds to a layer in the face mask. Therefore, the light penetrates the entire

face mask.
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